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Solution QP Code 78047 Nov 2019 SEM-VI-75-25 ATKT 

(2½ Hours)                                                                                                                           [Total Marks: 
75]     
     
Note: 1) All questions carry equal marks and are compulsory. 
           2) Figures to the right indicate maximum marks for a question.      
       

Q1.  (A)  Attempt  any two  sub-questions from a), b) and c) in MS-EXCEL 
(True or False) 

(2) 

  a) When data is filtered it is also sorted in the ascending order. F 
  b) Solver allows you to solve for more than one variable. T 
  c) A function can contain another function in its argument. T 
     
 (B)  Attempt  any two  sub-questions  from d), e) and f) in VISUAL BASIC 

(Multiple Choice) 
(2) 

  d) The full form of VBP is ________.  

   A) Visual Binary Project                             B) Visual Basic Project 
C) Very Basic Project;                             D) Visual Bio Parameter 

 

  e) The standard prefix for command Button is ________.  

   A) cmd        B)com                   C) comd            D)cdm  

  f) Visual Basic controls are ____________.  

   A)codes                   B) objects                   C)rules            D) part of the menus  

     
 (C)  Attempt any six  sub-questions from g), h), i), j), k), l), m), n), o) in  

E-Commerce. (True Or False). 
(6) 

  g) E- Market, EDI and Internet are parts of E-Commerce.                                                 T 

  h) Security is the major drawback of E-commerce.       T T 

  i) Portals are one of the B2B model.                                                                                                F 

  j) Authentication ensures that the buyer and seller do not deny that they have 
initiated the transaction.                                                                                                             

F 

  k) Private key encryption has two keys.                                                                                          F 

  l) In SET, the customer’s credit card number is seen by the merchant.                         F 

  m) Cipher texts are readable texts.                                                                                                  F 

  n) One of the payment systems in E-Commerce is online stored value systems.               T 

  o) A digital signature is a digital code that is attached to a message sent 
electronically.  

T 

     
 (D)  Attempt any five  sub-questions from p), q), r), s), t), u), v), w) in E-

Commerce. (Multiple Choice) 
(5) 

  p) In ________   revenue model, revenue is generated from sales of goods, 
information or services. 

 

   A)Affiliate    B)Sales               C)Transaction     D)Advertising  
  q) Online retail stores are often called as_________.  
   A) Portal    B)Market Creator C) E-Tailer       D)Community Provider  
  r) The full form of SSL in E-Commerce is Secure _______ Layer.  
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   A) Socket    B) soft              C) secret      D) sanctioned 
 

 

  s) olx.com is ____________ model.  
   A)B2C                    B)B2B               C)C2C                       D)  C2B  
  t) The full form of P2P in E-Commerce is _________.  
   A) Peer to Peer                              B) Person to Person 

C) Peer to Person                              D)Person to Peer 
 

  u) Decryption is done by ___________ with the help of private key.  
   A) Sender         B) Receiver      C) Both             D) Agent  
  v) It is a convention that all sites that use SSL connection while making a 

secure connection, use _____________instead of HTTP. 
 

   A)SMTP    B)HTTPS               C)FTP                      D)TCP/IP  
  w) The technology used to bring Internet content and services to mobile 

phones and other wireless devices is called________________. 
 

   A) WAP    B) SAP              C)WMP        D) WIP  
     
Q2. (A)  Answer any one sub-question from a) and b) in E-Commerce. (8) 
  a) Explain i) advertising revenue model       ii)content provider 

Theory. (Students can write answers in their own words. Please give marks 
as long as the content is correct.) 

 

  b) Explain the Different payment Systems in E-commerce. 
Theory. (Students can write answers in their own words. Please give marks 
as long as the content is correct.) 

 

     
 (B)  Answer any one sub-question from c) and d) in E-Commerce (7) 
  c) Explain SET in detail. 

Theory. (Students can write answers in their own words. Please give marks 
as long as the content is correct.) 

 

  d) What is M-Commerce? What are its applications? 
Theory. (Students can write answers in their own words. Please give marks 
as long as the content is correct.) 

 

      
Q3. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 
  a) The following data has been entered in a worksheet. 

 
 A B C D E F G 
1 NAME ECO MHRM TAX TOTAL AVERAGE  GRADE 
2 SUNITA 66 77 70    
3 JAY 80 82  87    
4 SEEMA 45 54 55    
5 AARTI 40 45 48    
6 HIRAL 77 84 80    
7 PRAKASH 65 66 69    

Write steps to  
i) Find the Total marks in column E. 
ii) Find the Average marks in column F. 
iii) Assign Grade in Column G using the following policy: 

Total Marks Grade 
240  or more O 
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180 or more but below 240 A 
Less than 180 B 

ANS:   
Total Marks:                                                         (2 Marks) 
1. Select E2 and type =SUM (B2:D2) and press enter. 
2. Select E2 and drag the fill handle till E7. 
Average Marks:                                                     (2 Marks) 
1. Select F2 and type =AVERAGE (B2:D2) and press enter. 
2. Select F2 and drag the fill handle till F7. 
Grade:                                                                   (4 Marks) 
1. Select G2 and type the formula =IF(E2>=240,"O",IF(E2>=180,"A","B"))   
2. Select G2 and drag the fill handle to G7.                                       

     

  b) Consider the following worksheet 
 A B C D 
1 NAME TAXABLE INCOME INCOME TAX SURCHARGE 
2 RAHUL 800000   
3 ANJALI 1000000   
4 POOJA 1500000   
5 RAJ 650000   
6 KAJOL 400000   
7 ADITYA 2400000   
8 SEEMA 600000   

Write steps to calculate  
i) Income Tax in column C where Income-Tax is calculated as follows. 
 

       Taxable Income       Rate 
         First 5,00,000         Nil 
         Next 3,00,000        10% 
         Excess        20% 

ii) Surcharge in column D, where surcharge is 5% of the income tax for 
those whose taxable income is above Rs.10, 00,000 otherwise there is no 
surcharge. 
ANS:   

i) To calculate Income Tax:                                                               (5 Marks) 
1. Select C2 and type =IF (B2<=500000, 0, IF (B2<=800000, (B2-
500000)*.10, (B2-800000)*.20+500000*.10)) and press enter. 
2. Select C2 and drag the fill handle to C8. 
ii) To calculate surcharge:                                                                 (3 Marks) 
1. Select D2 and type =IF (B2 > 1000000, C2*5%, 0) and press enter. 
2. Select D2 and drag the fill handle to D8. 

 

     
 (B)  Answer any one  sub-question from  c) and  d) in MS-EXCEL (7) 
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  c) Consider the following worksheet: 

 A B C D E F 
1 NAME  CITY DEPT SALARY HRA DA 
2 NAKUL AGRA HR 42000   
3 FALAK BHOPAL IT 35000   
4 PARTH MUMBAI HR 56000   
5 IRA AGRA SALES 45000   
6 RISHI MUMBAI IT 72000   
7 KIARA BHOPAL SALES 50000   
8 SAMAR MUMBAI SALES 75000   
9 MEERA AGRA IT 26000   

Write steps to perform the following: 

i) To compute HRA as 25% of the Salary for salary up to 40,000 otherwise 

40% of the salary in E. 

ii) To compute the DA as 120% of salary for salary above 60000 otherwise 

85% of salary in column F. 

iii) To find the total of salary of only the MUMBAI City in cell B11. 

(i) To compute HRA 

1. Select E2 and type the formula 

     =IF (D2<=40000, D2*25%, D2*40%) and press enter. 

2. Select E2 and drag the fill handle to E9. 

 (ii) To compute DA 

1. Select F2 and type the formula  

      =IF (D2>60000, D2*120%, D2*85%) and press enter. 

2. Select F2 and drag the fill handle to F9. 

(iii) To find the total of salary of only the MUMBAI City in cell B11. 

1. Select B11 and type the formula 

       =SUMIF (B2:B9,"MUMBAI", D2:D9) and press enter.   (Marks 3+3+1)                                                                                                                

 

     
  d) The following worksheet displays the distance in Kilometers. 

 A B C D E F G 
1 DISTANCE TRAIN 

FARE 
BUS 
FARE 

 DISTANCE TRAIN 
FARE 

BUS 
FARE 

2 42    0 10 12 
3 34    20 20 25 
4 5    40 35 45 
5 65    60 50 60 
6 120    80 70 80 
7 85    100 90 100 
8 22       

Write the steps to find the train and bus fare using VLOOKUP function in 
columns B and C. Policy table to be referred for finding the train and bus 
fare is given in the range E1:G7. 
(Note if the Distance is say 32, which is above 20 and below 40 then the 
Train Fare will be 20 ) 
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ANS: 
i)To calculate Train Fare  

1.     1.  Select B2 and type the formula =VLOOKUP(A2,$E$2:$G$7, 2, TRUE) 
       OR =VLOOKUP(A2,$E$2:$G$7, 2) and press enter. 
2. Select B2 and drag the fill handle to B8. 

ii)To calculate Bus Fare 
1. Select C2 and type the formula =VLOOKUP(A2,$E$2:$G$7, 3, TRUE) 
      OR =VLOOKUP (A2,$E$2:$G$7, 3) and press enter. 
2. Select C2 and Drag the fill handle to C8.                              MARKS (4+3) 

     
Q4. (A)  Answer any one  sub-question from  a) and b) in MS-EXCEL (8) 

  a) The following data is entered in a worksheet regarding expenses during 
September, October, November and December. 

 A B C D E 
1 ITEM SEPTEMBER OCTOBER NOVEMBER DECEMBER 
2 PRODUCTION 250000 255000 300000 320000 
3 TRANSPORT 75000 76000 77000 77000 
4 HR 10000 10000 10000 12000 
5 ADVERTISING 50000 55000 62000 67000 
6 TOTAL     

Write steps to 
 i) Find the total expenses in each month in the cells B6, C6, D6 and E6. 
ii) Create 3-D Bar chart for expenses of September, October, November and 
December. 
iii) Create a Pie chart for the expenses on Production. 
iv) Create a Line diagram for the expenses on Transport and Advertising. 
ANS: 
i) Find the total expenses in each month in the cells B6 to E6. 
          1. Select B6 and type  
          =SUM (B2:B5) OR =B2+B3+B4 + B5 and press enter. 
          2. Select B6 and drag the fill handle to E6. 
ii) To create 3-D Bar chart for the data. 

1. Select the data A1:E6 (or A1:E5). 
2. From the Insert tab, select bar chart, then select sub type 3-D. 

iii) To create Pie chart for the expenses on Production. 
1. Select the data A2:E2 (or B2:E2)  
2. From the Insert tab, select Pie chart, then select any sub type. 

iv) To Create a Line diagram for the expenses on Transport and 
Advertising. 

1. Select the data A3:E3 and A5:E5.  
2. From Insert Tab select Line and then select any Sub type.   

                                                                                                         (Marks 2+2+2+2) 
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  b) The following table shows Product, Quantity and Price of the Biscuits sold.  
 A B C D 
1 NAME OF BISCUITS QUANTITY PRICE REVENUE 
2 OREO 150 50  
3 MONACO 220 25  
4 KRACKJACK 200 20  
5 MARIE 250 25  
6 BOURBON 350 40  
7 HIDE & SEEK 400 30  
8 TOTAL REVENUE    

Write steps to find Revenue of each type of Biscuit and Total revenue in 
column D.   
Write steps in Excel using Solver to find what should be the price of each 
type of Biscuit in order to achieve total Revenue of 60000. 
(REVENUE = QUANTITY*PRICE) 
ANS: 
i) REVENUE 
1. Select D2 and type =B2*C2 and press enter. 
2. Select D2 and drag the fill handle to D7. 
ii) TOTAL REVENUE 
1. Select D8 and type =SUM (D2:D7) and press enter. 
iii) SOLVER 

1. Select D8 and from the Data Tab select Solver. 
2. In the dialog box in the ‘Set objective’ option the cell D8 is already  

              selected. 
3. In the ‘To’ option select ‘Value of’ and type 60000 in the text box. 
4. In the option ‘By Changing Variable cells’ text box enter C2:C7 
5. Then click on Solve. When Solver will obtain the result, click on ok.                          

                                                                                                                    (Marks 
2+1+5) 

 

     
Q4. (B)  Answer any one  sub-question from  c) and d) in MS-EXCEL (7) 
  c) The following data has been entered in a Excel worksheet 

 
 A B C D 
1 NAME CITY SALARY BONUS 
2 ALIYA CHENNAI 42000 4200 
3 BINITA HYDERABAD 35000 3500 
4 KABIR JAIPUR 30000 3000 
5 NAKUL MUMBAI 50000 5000 
6 DAMINI CHENNAI 45000 4500 
7 ADITYA HYDERABAD 65000 6500 
8 ISHANI MUMBAI 54000 5400 

Write steps to 
i) Display only those rows where the City is “CHENNAI”. 
ii) Display only those rows where Salary is above average Salary. 

      iii) Display only those rows where the Bonus is more than 4,000 but less 
             than 5,500. 
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ANS:      

i) Display only those rows where the City is ‘CHENNAI’. 
  1. Select the data A1:D8 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of City and from text filter select equals 
  4. Type ‘CHENNAI’ in the dialog box and click on ok. 
ii) Display only those rows where Salary is above average Salary.        
  1. Select the data A1:D8. 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Salary and from number filter select   
       ‘above average’. 
iii) Display only those rows where the Bonus is more than 4,000 but less 
       than 5,500. 
  1. Select the data A1:D8. 
  2. From DATA Tab select Filter. 
  3. Click on the drop down arrow of Bonus and from number filter select   
       ‘greater than’. 
  4. Type 4000 in the dialog box and then select ‘And’ 
  5.  Select ‘Less than’ then type 5500 and click on ok. 
                                                                                                             (Marks 2+3+3) 

     
  d) Explain the following functions in MS-EXCEL. 

1) DAY()     2) NOW()  3) YEAR() 4) TIME() 

5) CORREL()     6) COUNTA() 7)LARGE()  

ANS: 
(Give 1 mark if either definition or example or syntax is correct for each 
function) 
1. DAY (serial number): Returns the day of the month corresponding to a 
serial number or date text. The day returned has a value from 1 to 31. Note: 
Date text can be given in place of serial number. 
e.g. =DAY(35) gives 4 and = DAY("23-02-2019")gives 23. 
2. NOW ( ):  Returns the current system date and time.  
     e.g. =NOW() gives 17-11-2019 17:47 
3. YEAR (serial number): Returns the year corresponding to a serial 
number or date text. The year returned has a value from 1900-9999. 
e.g. =YEAR(35) gives 1900 and =YEAR(“22-11-2019”) gives 2019 
4. TIME (hour, minute, second): Returns the particular time in hh:mm 
AM/PM format. 
e.g. =TIME(14,23,45) returns 2:23PM 
5. CORREL(array1,array2): Returns the correlation coefficient between two 
data sets. 
e.g. If D1:D3 contains the values 45,34,67 and E1:E3 contains the values 
49,44,75 then CORREL(D1:D3,E1:E3) gives .983358 the correlation 
coefficient between these two data sets. 
We can also type =CORREL({45,34,67},{49,44,75}) which gives the same 
result .983358 
6. COUNTA(range): Counts the number of cells in a range that are not 
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empty. 
e.g. COUNTA(D1:D5) gives 2 if there are only two values in the cells from 
D1 to D5. 
7. LARGE (array, k): Returns the kth  largest value in the data set 
     e.g. = LARGE({45,23,67,87},3) gives 45 the 3rd largest value.  

     
Q5. (A)  Answer any one  sub-question from  a) and b) in VISUAL BASIC 

Students can use different methods to solve VB questions. Label names, 
textbox names etc. are user defined, so can be different from given in this 
solution. Give full marks for correct answer even if it is not same as the 
solution given here. VB 6 .Text is not necessary so please give marks even if 
.Text is not written. 

(8) 

  a) Write a project in VB to design a suitable form which allows the user to 
enter Name and Basic salary. Calculate DA as 60% of Basic Salary whenever 
basic salary is less than 40000 otherwise 80% of Basic Salary using a 
‘Calculate’ button and display the result.  

Object Property Setting 

Form Name frmDA 

 Caption DA 

Label1 Name lblName 

 Caption Name 

Label2 Name lblBsal 

 Caption BSalary 

Label3 Name lblDA 

 Caption DA 

Text1 Name txtName 

 Text (Blank) 

Text2 Name txtBsalary 

 Text (Blank) 

Text3 Name txtDA 

 Text (Blank) 

Command1 Name cmdCalculate 

 Caption Calculate 

Command2 Name cmdExit 

 Caption Exit 

                                                                                                       (4 Marks) 

Private Sub cmdCalculate_Click()               (3 Marks) 

  If Val(txtBsalary)<40000 Then 

      txtDA = Val(txtBsalary)*.6 

  Else 

      txtDA = Val(txtBsalary)*.8 

  End If 

End Sub 

 

Private Sub cmdExit_Click()                        (1 Mark) 

End 

End Sub 
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  b) Write a project in VB to design a suitable form which allows the user to 
enter amount in Rupees and rate of conversion to Dollars and then calculate 
and display equivalent amount in Dollars. 

Object Property Value/Setting 
Form Name frmConvert 
 Caption Convert to Dollars 
Label Name lblRupee 
 Caption Rupees 
Text Box Name txtRupees 
 Text (Blank) 
Label Name lblRate 
 Caption Rate of Conversion 
Text Box Name txtRate 
 Text (Blank) 
Label Name lblDollar 
 Caption Amount in Dollars 
Text Box Name txtDollar 
 Text (Blank) 
Command Name CmdConvert 
 Caption Convert 
Command Name CmdExit 
 Caption Exit 

Private Sub CmdConvert_Click()                                                                                   
    txtDollar = Val(txtRupees)/Val(txtRate) 
End Sub                                                                                                                 
Private Sub CmdExit_click()                             
   End 
End Sub                                                                                                  (Marks 4+3+1) 

 
 

Q5. (B)  Answer any one  sub-question from  c) and d) in VISUAL BASIC (7) 
  c) Write a project in VB to design a suitable form which allows the user to 

enter an integer and calculate and display the factorial of that integer when 
the “Calculate” button is clicked. 
(Factorial of N= 1*2*3----------*N) 

Object Property Value/Setting 

Form Name FrmFactorial 

 Caption/Text Factorial 

Label 1 Name lblN 

 Caption/Text Number 

Label 2 Name lblF 

 Caption/Text Factorial 

Text box1 Name txtN 

 Text (Blank) 

Text box Name txtF 

 Text (Blank) 

Command Name/Text CmdFactorial 

 Caption Calculate 

Command Name CmdExit 

 Caption/Text Exit 
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Private Sub CmdFactorial_Click()                        

   Dim I, N, Factorial  As Integer 

   N = Val(txtN.Text) 

   Factorial=1 

   For I=1 to N step 1 

       Factorial= Factorial* I 

   Next  I 

   txtF.Text = Factorial 

End Sub 

 

Private Sub CmdExit_click()                        

   End 

End Sub                                                                                     (Marks 3+3+1) 

 
  d) Write a project in VB to design a suitable form to enter any two integers and 

display average of these two integers.  
Object Property Value 
Form Name frmAverage 
 Text Average 
Label1 Name lblFirst 
 Text First Number 
Label2 Name lblSecond 
 Text Second Number 
Label3 Name lblAverage 
 Text Average 
Text Box1 Name txtF 
 Text Blank 
Text Box2 Name txtS 
 Text Blank 
Text Box3 Name txtAverage 
 Text Blank 
Command1 Name cmdCalculate 
 Text Calculate 
Command2 Name cmdExit 
 Text Exit 

Private Sub cmdCalculate_Click() 
txtAverage.Text = (Val(txtF.Text) + Val(txtS.Text))/2 
End Sub 
 
Private Sub cmdExit_Click() 
End 
End Sub                                                                                       (Marks 3+3+1) 

 
 

     
 


